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The liver is central in maintaining glucose homeostasis. Indeed, impaired hep-
atic glucose uptake has been implicated in the development of hyperglycemia
in type II diabetes (T2D) and non-alcoholic fatty liver disease (NAFLD). How-
ever, current approaches to evaluate glucose mobilization rely on indirect mea-
surements that do not provide spatial and temporal information. Here, we de-
scribe confocal-based intravital microscopy (IVM) of the liver that allows the
identification of hepatocyte spatial organization and glucose transport. Specifi-
cally, we describe a method to fluorescently label hepatic landmarks to identify
different compartments within the liver. In addition, we outline an in vivo fluo-
rescent glucose uptake assay to quantitatively measure glucose mobilization in
space and time. These protocols allow direct investigation of hepatic glycemic
control and can be further applied to murine models of liver disease. © Pub-
lished 2021. This article is a U.S. Government work and is in the public domain
in the USA.

Basic Protocol 1: Mouse surgical procedure and positioning for liver intravital
imaging
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INTRODUCTION

The liver plays a vital role in regulating glucose homeostasis by coordinating various glu-
cose metabolic pathways, including glycogenesis, glycogenolysis, glycolysis, and glu-
coneogenesis. Dysregulation of glucose homeostasis is a hallmark of metabolic diseases
such as T2D and NAFLD. Despite its importance in disease progression, hepatic glucose
uptake cannot be measured directly with spatial and temporal precision using current
methods.
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Figure 1 Intravital microscopy setup. (A) Schematic representation of the hepatic lobule. HA,
hepatic artery; PV, portal vein; BD, bile duct; CV, central vein. (B) Anesthetized mouse positioned
on the stage of an inverted microscope with the liver surgically exposed. (C) Surgical prep under
nose-cone-administered anesthesia, demonstrating the shaved area on the abdomen and size of
the surgical opening. (D) Microscope stage set up for IVM including nose cone for anesthesia,
custom-made metal insert with a central 35-mm circle opening coved by a 40-mm coverglass,
and cardboard insert to raise the mouse’s body away from the exposed liver. A strip of gauze is
used to adjust the liver against the coverslip. (E) Mouse anesthetized using nose cone and body
temperature is controlled using a heat pad.

Hepatocytes are organized into a repetitive hexagonal unit called the hepatic lobule (Fig.
1A). Blood flows directionally from the six corners of the lobule toward a single central
vein, generating a gradient of nutrients, oxygen, and hormones across the porto-central
axis. Consequently, hepatocytes are exposed to different microenvironments, which af-
fects their gene expression patterns and metabolic activities—a phenomenon known as
liver zonation (Ben-Moshe & Itzkovitz, 2019). Specifically, periportal (PV) hepatocytes
are known to engage in gluconeogenesis, whereas pericentral (CV) hepatocytes are in-
volved in glycolysis. As such, liver zonation is an important consideration for hepatic
glucose homeostasis.

Fluorescent light microscopy has revolutionized the ability to visualize cellular processes
in living systems. In the past two decades, the development of fluorescent protein vari-
ants, along with advancements in optics and image analysis, have made it possible to
track processes in space and time in cultured cells (Lippincott-Schwartz, Snapp, & Ken-
worthy, 2001). More recently, new technologies to manipulate the genomes of various
organisms, as well as new in vivo imaging modalities, have allowed the extension of these
light-based approaches to intact tissues (Entenberg et al., 2018; Weigert, Porat-Shliom,
& Amornphimoltham, 2013). This collection of light microscopy approaches applied to
live, intact tissues is collectively referred to as intravital microscopy (IVM). IVM meth-
ods now offer great opportunities to understand liver structure and function (Gola et al.,
2021; Meyer et al., 2017; Porat-Shliom et al., 2016; Ritsma et al., 2013; Tavakoli, Tsek-
ouras, Day, Dunn, & Presse, 2019). Furthermore, these approaches will be powerful in
resolving the functional heterogeneity of hepatocytes, which is impossible to recreate in
vitro.
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Table 1 Reagents for Mouse Liver Intravital Microscopy

Mouse body
weight (g) Board (cm)

Board thickness
(mm)

Imaging window
(cm)

Small (S) 17-20 12 × 8 1.5 2.5 × 2.3

Medium (M) 22-25 15 × 8 2.5 2.0 × 2.0

Large (L) >30 15.5 × 8 4.0 3.5 × 1.8

Here, we present a comprehensive protocol for performing intravital microscopy of the
murine liver. In Basic Protocol 1, we outline the steps for surgical exposure of the liver
and its positioning on the microscope stage. We also discuss considerations taken to avoid
tissue damage/ischemia and to monitor mouse body temperature during the procedure.
Next, in Basic Protocol 2, we delineate the steps taken to fluorescently label hepatic com-
partments and to identify PV and CV hepatocytes. Finally, in Basic Protocol 3, we de-
scribe a functional assay to evaluate glucose uptake using 2-(N-(7-nitrobenz-2-oxa-1,3-
diazol-4-yl)amino)-2-deoxyglucose (2-NBDG). Basic Protocol 3 also includes an image
analysis strategy to quantify the rate of glucose uptake and its retention within hepato-
cytes in different parts of the lobule. Together, IVM of hepatocyte spatial organization
in combination with dynamic transport of fluorescent glucose provides physiological in-
sight into hepatic glycemic control in real time. These assays can be further applied to
different mouse models of liver disease.

BASIC
PROTOCOL 1

MOUSE SURGICAL PROCEDURE AND POSITIONING FOR LIVER
INTRAVITAL IMAGING

Here, we describe in detail microscope setup, mouse preparation, mouse anesthesia, and
a surgical procedure for liver exposure. Next, we provide guidelines on how to position
the mouse on the microscope stage to minimalize motion artifacts due to heartbeat and
respiration while maintaining proper perfusion.

IMPORTANT NOTE: All experiments involving animals must be performed under an
animal protocol approved by your animal care and ethics committee. Personnel should
be properly trained before proceeding.

Materials

Clidox disinfectant (VWR, MSPP-96118F)
Mus musculus
70% (v/v) ethanol
FORANE (isoflurane, USP) liquid for inhalation, 250 ml (Baxter, 10019-360-60)
Heparin sodium, 1000 USP U/ml (Hikma, 0641-0391-12)
Normal saline (0.9% sodium chlorine; Fisher Scientific, cat. no. 7210-16)

Leica SP8 (or other commercial) confocal microscope
Custom-made stage cardboard of appropriate dimensions (see Table 1)
Custom-made aluminum stage insert (3 mm thick) with 35-mm depression
40-mm coverslips (Bioptech, 40-1313-0319)
Surgical gauze
1
2 -inch. masking tape
Anesthesia machine: AMD-3 plus (Somni, AMD-17106)
Reusable chemical heat packs
Mouse heat pad (ALA Scientific Instruments, HEATINGPAD-1/2)
Space heat pad (AIMSTM, AIMSTM GGP1)
Ultra Fine U-100 Insulin Syringes, 31-G (BD, BD328438)
Hair clipper Stefkovich et al.
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Surgical scissors
Cautery System (Gemini, GEM 5917)
Surgical forceps, curved tip
Cotton-tip applicators
Heat pad with rectal probe (ALA scientific instruments, HEATINGPAD-1/2)
Aquasonic 100 ultrasound transmission gel (Parker lab Inc)

Microscope preparation
1. IVM of the liver can be performed on any commercial inverted confocal microscope

(Fig. 1B). Standard microscope stages have various inserts to accommodate slides
or tissue culture plates. For IVM, a flat surface with a 35-mm circular opening cov-
ered with a 40-mm coverglass is required. In some cases, 35-mm-plate inserts can
be modified to hold a mouse. Alternatively, a custom-made metal insert, 3 mm in
thickness, with a central 35-mm circular opening can be fabricated. The coverglass
should be cleaned thoroughly on both sides using 70% ethanol before use.

2. Select the objective based on area size, spatial resolution, and the length of the imag-
ing session. In general, lower magnification is useful for imaging larger areas at
lower resolution, whereas higher magnification increases the resolution of smaller
structures. One should consider that motion artifact (see below) will be more notice-
able when using higher magnifications.

3. Select stage cardboard dimensions based on mouse weight (see Table 1) and tape the
stage insert with the imaging window (in the cardboard) directly over the coverslip
(Fig. 1D). Minimizing motion artifacts due to respiration and/or heartbeat is central
to IVM; the cardboard is used to absorb such motion while also creating a barrier
between the body and the microscope stage. Place a small strip of gauze (1 × 8 cm)
across the cardboard imaging window and fix it with masking tape on one side (Fig.
1D).

4. Warm the stage area using chemical heat pads at least 30 min prior to imaging. This
will help maintain the mouse body temperature during the imaging experiment.

Mouse anesthesia and surgical procedure
5. Clean anesthesia induction chamber with Clidox disinfectant; this will remove odor

of the previous mouse, which reduces stress.

6. Place the mouse in the induction chamber, and turn on the oxygen condenser and
3% isoflurane for 5 min. When the mouse is anesthetized, transfer it onto the heating
pad and maintain anesthesia using 1% isoflurane delivered via a nose cone (Fig. 1C).

This procedure should be done using isoflurane as opposed to other anesthetic agents
such as ketamine and xylazine to avoid stimulation of hepatic gluconeogenesis, which
may affect the rate of glucose uptake in the liver (Bevan, Rose, & Duggan, 1997).

7. Inject 20 U heparin intraperitoneally (i.p.; dilute 20 μl heparin from 1000 U/ml stock
into 30 μl saline). The liver is prone to injury and ischemia; heparin ensures proper
perfusion during the imaging study.

8. Shave the mouse abdomen using a hair clipper and remove hair using gauze soaked
with 70% ethanol (Fig. 1C, left).

Removing hair from the surgical site is crucial, as any errant hairs on the liver surface
can impede your field of view.

9. Expose the liver by making a 2- to 3-cm incision along the ribcage starting from the
xiphoid and ending at the left lateral side of the abdomen. Initially, the outer skin
is cut with scissors, and then the muscle layer is cut, using a cauterizer as needed
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to avoid bleeding. To avoid burning the liver with the cauterizer, carefully open the
abdominal cavity on the lateral side and insert wet gauze (soaked in normal saline)
between the liver and muscle layer before starting with the major incision (Fig. 1C,
right).

Mice injected with heparin will be susceptible to bleeding. Using a cauterizer to avoid
excessive bleeding is crucial for mouse survival.

Positioning of the mouse
10. Position mouse on the microscope stage with the exposed left lateral lobe of the liver

laid against the coverslip. Use gauze to separate the liver lobe from the intestines and
mouse by placing it between the liver and abdomen (Fig. 1D). Stretching the mouse
flat on the microscope stage may help reduce motion (Fig. 1E).

11. Reposition the mouse if breathing causes the liver position to shift on the cover-
slip. Adjust the liver position very gently using a cotton-tipped applicator soaked in
normal saline.

12. Secure the mouse’s neck to the stage using tape to prevent motion artifacts upon
retro-orbital injection of fluorescent tracers during imaging. Adjust the nose cone so
that the mouse remains under the plane of anesthesia while allowing access to the
eye. Maintain mouse anesthesia through delivery of 1% isoflurane via a nose cone
on the microscope stage.

Higher percentages of isoflurane can make the mouse gasp, causing exaggerated chest
movements that destabilize the liver during imaging.

13. Monitor and maintain the mouse body temperature using a heat pad with a rectal
probe. Avoid placing the heat pad directly against the skin to avoid overheating.
Additionally, avoid tissue dehydration by (1) using a microscope with an enclosed
chamber with humidity control or (2) applying Aquasonic 100 ultrasound transmis-
sion gel at the edges of the exposed cavity.

BASIC
PROTOCOL 2

FLUORESCENT LABELING AND INTRAVITAL IMAGING OF MOUSE
HEPATIC COMPARTMENTS

This protocol describes how to (1) fluorescently label different compartments within the
hepatic lobule, (2) identify PV regions, and (3) select the ideal imaging area for time-
lapse IVM.

Materials

Appropriate fluorescent dyes (see Table 2)
31-G insulin syringe

Additional reagents and equipment for mouse anesthesia, surgery, and intravital
imaging (Basic Protocol 1)

Table 2 Reagents for Fluorescent Labeling of Hepatic Compartments

Fluorescent dyes Compartment Concentration Source (cat. no.)

Alexa Fluor® 647–conjugated
anti-mouse/human CD324
(E-cadherin) antibody

PV hepatocytes 0.5 μg/g Biolegend
(147308)

2 M tetramethylrhodamine-dextran Vasculature 18 μg/g Thermo Fisher
(D7139)

Hoechst 33342 Nuclei 2 μg/g Thermo Fisher
(H357 Stefkovich et al.
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Figure 2 Imaging different compartments in the liver. (A) IVM image of the liver parenchyma.
Sinusoids are labeled with 2 M dextran (cyan), PV hepatocytes with Alexa-647-conjugated E-
cadherin antibody (magenta), and nuclei with Hoechst 33342 (yellow). The white hexagon denotes
one lobule, and the dashed rectangle the hepatic acinus. PV, portal vein; CV, central vein. Scale
bar, 50 μm. (B) Close-up view of the hepatic acinus. (C) Selected frames from time-lapse IVM
demonstrating how fluorescent blood tracers such as 2 M dextran (cyan) can be used to identify
PV and CV regions based on the direction of blood flow. Scale bar, 50 μm.

1. Anesthetize the mouse and maintain anesthesia using nose cone (Basic Protocol 1).

2. Inject 0.5 μg/g Alexa Fluor® 647–conjugated anti-mouse/human CD324 (E-
cadherin) antibody diluted in 1× heparin (total volume of 50 μl) via retro-orbital
injection using a 31-G insulin syringe.

3. Inject 2 μg/g Hoechst 33342 diluted in 1× heparin (total volume 50 μl), via retro-
orbital injection using a 31-G insulin syringe. Use the other eye for Hoechst 33342
injection, as the probe tend to precipitate if combined with other fluorescent probes.

4. Incubate 30-45 min to allow labeling of PV hepatocytes and nuclei, while controlling
the body temperature with a heating pad.

5. Prepare microscope and mouse for imaging (Basic Protocol 1).

6. Secure the mouse’s neck to the stage with tape.

7. Minimize motion, then retro-orbitally inject 18 μg/g of fluorescent dextran diluted
in 10 USP units/ml heparin (total volume 50 μl) using a 31-G insulin syringe.

8. Assess blood flow by observing the fluorescent dextran signal via the eyepiece.
Strong labeling of the vasculature should occur within 1 s of injection (Fig. 2).

9. Identify PV from CV areas of the lobule using E-cadherin labeling and the direction
of the blood flow. Blood flows from the PV towards the CV regions (Fig. 2C).

10. Select an imaging area that is stable and has a good blood flow. This can be assessed
by looking through the eyepiece and acquiring a short IVM time-lapse to evaluate
stability over time.

Stefkovich et al.
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Video 1 The liver was labeled with Hoechst (nuclei; yellow) and Alexa-647-conjugated E-
cadherin antibody (magenta) to mark PV regions prior to time-lapse IVM acquisition. Fluorescent
dextran (2 M; cyan) was injected while acquiring time-lapse IVM, which can be used to identify PV
and CV regions based on the direction of blood flow. Magnification: 20×; 512 × 512; frames were
acquired every 2.5 s. Scale bar, 50 μm.

It may take 20-30 min for the liver to settle down and form stable contact with the cov-
erslip.

11. Set up time-lapse IVM to acquire 512 × 512 pixels every 2.5 s for 10 min using the
20× objective (Fig. 2 and Video 1).

BASIC
PROTOCOL 3

MOUSE HEPATIC GLUCOSE UPTAKE ASSAY AND INTRAVITAL IMAGE
ANALYSIS

This protocol describes how to use the fluorescent glucose analog 2-(N-(7-nitrobenz-2-
oxa-1,3-diazol-4-yl)amino)-2-deoxyglucose (2-NBDG) to measure glucose mobilization
between different compartments in the hepatic lobule of a live, anesthetized mouse. A
step-by-step guideline for image analysis follows. This procedure provides an alterna-
tive to other methods of measuring hepatic glucose uptake by providing spatiotemporal
information. The protocol can be completed in 45-60 min per mouse.

Materials

Dextrose 50% (Hospira, 000622)
2-NBDG (Thermo Fisher, N13195)

Stefkovich et al.
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Video 2 Sinusoids were labeled with fluorescent dextran (2 M; red) ahead of imaging. 2-NBDG
(green) was injected while acquiring time-lapse IVM. Magnification: 20×; 512 × 512; frames were
acquired every 2.5 s. Scale bar, 50 μm.

31-G insulin syringe
ImageJ software or similar
Excel spreadsheet software

Additional reagents and equipment for mouse anesthesia, surgery, and intravital
imaging (Basic Protocol 1)

Image acquisition
1. Fast the mice for 4-6 hr prior to imaging.

2. Prepare the microscope and surgically expose the liver as described in Basic Protocol
1.

3. Secure the mouse’s neck to the stage with tape.

4. Minimize motion, then retro-orbitally inject 18 μg of dextran per gram of mouse
body weight (diluted to a total volume of 50 μl in 10 USP U/ml heparin) using a
31-G insulin syringe.

5. Set up time-lapse IVM to acquire 512 × 512 pixels every 2.5 s for 30 min. Use the
20× objective and select the field of view as described in Basic Protocol 2 (Video
2).Stefkovich et al.
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Figure 3 Hepatic glucose uptake and retention quantified using intravital microscopy. Represen-
tative frames from time-lapse IVM in which sinusoids were labeled with 2 M dextran (red) and the
fluorescent glucose analog 2-NBDG (green in overlay, or gray). Dashed circles around periportal
hepatocytes indicate the portal vein (PV) regions; dashed rectangle around pericentral hepatocytes
indicate the central vein (CV). White arrows denote the direction of blood flow. Time is shown as
minutes:seconds. (B) Glucose uptake measured as mean gray value over time in PV, mid-lobular
(M), and CV (three ROIs from one mouse). (C) Rate of glucose uptake in PV, M, and CV. (D)
Glucose retention calculated as the ration between the mean gray values in hepatocytes over the
mean gray values in the sinusoid. Errors bars, SEM.
Time-lapse IVM.

6. Dissolve 2-NBDG (6.83 μg/g mouse) in 50% dextrose (1 g/kg body weight). Inject
50 μl 2-NBDG retro-orbitally with a 31-G insulin syringe while acquiring time-lapse
IVM (Fig. 3A).

Keep 2-NBDG stock solution on ice, protected from light, for up to 6 hr.

Expect 2-NBDG signal to appear in sinusoids located in the PV area (Fig. 3A) within
10 s after injection and to be taken up by hepatocytes within 10-15 min.

Image analysis
7. Open the time-lapse LIF (.lif) file with ImageJ. Stefkovich et al.
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Figure 4 Sample data from intravital hepatic glucose uptake assay. (A) 2-NBDG data from the
hepatocyte area. (B) 2-NBDG uptake data. (C) Scatterplot with trend line. The three data points
with mean gray values near the top right represent outliers that were deleted. (D) Data for sinusoid
and hepatocyte mean gray values.

8. Brighten and smooth the dextran signal. Click on Image > Adjust > Brightness/
Contrast and enhance the dextran signal as needed, then click Process > Smooth.

9. Identify PV and CV as described in Basic Protocol 2 using the 2-NBDG channel.
Create three ROIs (regions of interest) of the same size on the PV-CV axis: PV, M
(mid-lobular), and CV.

PV regions can be identified by labeling with Alexa-conjugated E-cadherin antibody (Fig.
2C) or by time-lapse IVM, in which 2-NBDG signal appears first at the PV (Fig. 3A).

10. Crop the three ROIs and save them separately.

11. Split the channels

12. Threshold the dextran channel (Image > Adjust > Threshold).

13. Adjust the threshold bar so that only the dextran signal is included (shaded red).
Select the thresholder regions (Edit > Selection > Create selection).

14. Save the selections (File > Save as > Selection).

15. Transfer the selection of sinusoids to the 2-NBDG channel by opening the saved
selection (File > Open saved selection).

16. Measure 2-NBDG in the sinusoid area (Image > Stacks > Plot z axis profile > Data
> Copy all data).

17. Paste the data points into an Excel spreadsheet. The first column (x) is time in sec-
onds and the second column (y) is the mean gray value inside the sinusoid, at each
time point.

18. Measure 2-NBDG in the hepatocyte area (2-NBDG channel > Edit > Selection
> Make inverse > Image > Stacks > Plot z axis profile > Data > Copy all
data).

19. Paste data points into the Excel spreadsheet. The first column (x) is time in seconds
and the second column (y) is the mean gray value in the hepatocytes, at each time
point (Fig. 4A).

20. Plot the mean gray intensity of the different parts of the hepatic lobule
(Fig. 3B).

Stefkovich et al.
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Calculating the rate of 2-NBDG uptake
21. Identify the time point in the hepatocytes column at which the signal dramatically

increases; this is likely the time point where the 2-NBDG was injected. Copy the
mean gray values from this column within the 2-min period after that time point.
Paste these values into a separate column.

22. Copy the time values for that same 2-min period and paste them into a column (Fig.
4B).

23. Create a scatterplot. If the liver preparation was stable, the scatterplot should be
linear.

24. Add a trendline to the scatterplot. Select “Linear” in the Format Trendline box and
check “Display equation on chart” and “Display R-squared value on chart.” If the
points fit a linear equation well, the R2 value will be close to 1.

Motion artifacts can result in outlier data points that can be removed. However, the re-
moval of multiple data points will result in an inaccurate linear fit. Therefore, each time-
lapse should be evaluated for stability and quality of data. An example is provided in
Figure 4C.

25. Compare the slope (in the example above, slope = 0.3995) between zones and mice.
A higher value reflects a higher rate of uptake (Fig. 3C).

Calculating 2-NBDG retention in hepatocytes
26. The rate of glucose retention can be calculated as the ratio of the mean gray value

of 2-NBDG in hepatocytes to the mean gray value of 2-NBDG in the sinusoids:

• ratio >1: More 2-NBDG in hepatocytes than in sinusoids;
• ratio <1: Less 2-NBDG in hepatocytes than in sinusoids;
• ratio = 1: 2-NBDG signal in hepatocytes = 2-NBDG signal in sinusoids.

27. Select time points from time-lapse IVM from which to calculate ratios. For example:
0 s (defined as the frame before 2-NBDG signal first appears) and 30 s, 2 min, 4 min,
and 6 min post 2-NBDG injection.

28. Copy and paste the mean gray values at the chosen time points, and paste them into
a new spreadsheet.

29. Subtract the background mean gray value prior to the appearance of the 2-NBDG
signal, for both the sinusoid and hepatocyte selections. Next, divide the hepatocyte
mean gray value by the sinusoid mean gray value (at each time point) to find the
ratio (Figs. 3D and 4D).

COMMENTARY

Background Information
IVM was first described in 1839 (Wag-

ner, 1839), when it was used to observe the
movement of leukocytes through blood ves-
sels in the translucent, webbed feet of frogs.
The development of novel fluorescent probes
since 1994 has made its application to a wide
range of intact tissues possible. IVM is par-
ticularly suited for studying liver physiology
because the liver can easily be slipped out
of the body cavity onto a coverslip and is
highly amenable to administration of fluores-
cent probes, eliminating the need to create
transgenic animals expressing fluorescently

tagged proteins. In these protocols, we have
described a novel method for measuring hep-
atic glucose uptake in real time in live mice
using intravital microscopy and the fluores-
cent glucose analog 2-NBDG. Previous meth-
ods have measured hepatic glucose uptake in
rats (Tsumura, Tsushima, Tamura, Hasebe, &
Kobayashi, 2019) and humans (Mari, Wahren,
DeFronzo, & Ferrannini, 1994) by perfus-
ing the livers with stable-isotope-labeled glu-
cose and quantifying the ratio of the car-
bon isotopes to determine net uptake. Positron
emission tomography (PET) has also been
used to measure glucose uptake in the liver Stefkovich et al.
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(Honka et al., 2018). Although these meth-
ods allow quantification of hepatic glucose up-
take in vivo, they lack spatial and temporal
resolution.

Here we describe protocols for IVM of the
liver, labeling of liver compartments, and eval-
uation of glucose mobilization using the flu-
orescent tracer 2-NBDG. Collectively, these
protocols allow the investigation of zone-
specific differences in hepatic glucose trans-
port. Applying these assays to liver disease
models will provide invaluable information on
hepatocyte regulation of glucose homeostasis
at the cellular level. The increased spatial res-
olution also permits examination into the roles
that non-parenchymal liver cells, the microen-
vironment, or the vasculature may have in
the regulation of glucose transport. For exam-
ple, hepatic glucose uptake might be impaired
in the liver due to inadequate vascularization
rather than dysfunctional glucose transporters,
a distinction that is impossible to test in iso-
lated hepatocytes. This assay is not without
limitations, however, as it cannot be used to
determine downstream fates of glucose, such
as glycogen deposition. Once taken up by hep-
atocytes, the NBD group is cleaved from the
glucose before the glucose is phosphorylated
in the first reaction of glycolysis (Yoshioka
et al. 1996).

Critical Parameters
Basic Protocol 1: Liver exposure and po-

sitioning on the microscope stage are key to
obtaining robust results. While surgically ex-
posing the liver, special attention should be
paid to avoid excessive bleeding and damage
to the liver parenchyma. In addition, position-
ing of the mouse on the microscope stage is
equally critical for two main reasons. First,
stable preparation for imaging is a prerequisite
for extracting quantitative information from
the images. Second, tissue damage may occur
during the positioning of the mouse on the mi-
croscope stage. Therefore, these steps are par-
ticularly sensitive to user manipulation and re-
quire precision and practice.

Basic Protocol 2: Labeling of the differ-
ent hepatic compartments is critically depen-
dent on the fluorescent probe concentrations
and the effective delivery of the probes. The
concentrations for the fluorescent probes de-
scribed here were determined empirically in
wild-type (C57Bl/6J) mice. Applying this pro-
tocol to other lines and/or disease models may
require adjusting these concentrations. In ad-
dition, retro-orbital injection, like any other
procedure, requires precision and practice. It

is therefore advisable to master the technique
before performing experiments.

Basic Protocol 3: The ability to quantify the
rate of glucose uptake is dependent on the sta-
bility of the region imaged. Minimizing mo-
tion artifacts is extremely important but should
be done with caution. Quantification of glu-
cose retention in the liver, however, can still
be done even if significant movement persists
because individual frames can be analyzed in-
dependently. Another key aspect of this assay
is ensuring that probes are sufficiently bright
once their signal appears in the liver, because
a dim signal will impede accurate threshold-
ing.

Troubleshooting
Table 3 lists problems that may arise with

these procedure along with their possible
causes and solutions.

Statistical Analysis
A Student’s t-test should be used in Basic

Protocol 3.

Understanding Results

Basic Protocol 1
The goal is to surgically expose the liver

and position the mouse on the microscope
(Fig. 1B and E) to allow visualization of the
hepatic lobule (Fig. 1A). To achieve this, the
abdomen should be shaved, and the incision
should expose the largest liver lobe. Bleed-
ing is to be expected once the muscle layer
is cut and can be controlled using a cauter-
izer (Fig. 1C). The microscope stage should
be heated, and a cardboard insert taped to ele-
vate the mouse’s body away from the exposed
liver. A narrow strip of gauze soaked in saline
attached to the insert can keep the liver hy-
drated and separated from the other internal
organs (Fig. 1D). The mouse should be posi-
tioned on the stage such that its abdomen is
flat against the insert and its nose just inside
the nose cone to maintain anesthesia while al-
lowing access to an eye for retro-orbital injec-
tion. Gauze placed over the mouse and heating
pad connected to a rectal probe help control
body temperature. In addition, ultrasound gel
around the edges of the incision prevents the
liver from drying out (Fig. 1E).

Basic Protocol 2
Retro-orbital injection is a convenient

mode to administer fluorescent probes to label
hepatic compartments. The sinusoids are la-
beled with high-molecular-weight dextran (2
M Kd), a probe that is retained for the duration

Stefkovich et al.
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Table 3 Troubleshooting

Problem Possible cause Solution

Mouse not becoming
anesthetized

Isoflurane tank needs to be refilled
or output is too low.

Fill tank or increase isoflurane output to 2%.

If administering anesthesia via i.p.
injection, an insufficient volume
may have been injected.

Inject an additional half dose, especially if the
mouse weighs >20 g.

Excessive bleeding
during surgical prep

Damage to muscle layer or liver
parenchyma occurred.

Cauterize to stop/prevent bleeding. Be mindful
of avoiding heat damage to the liver while
cauterizing. If direct damage to the liver occurs
or bleeding persists, euthanize the mouse.

Inability to find
stable field of view

Isoflurane levels are too high,
causing the mouse to gasp.

Lower isoflurane levels to 1-1.5%

Liver is too close to the body cavity. Use a saline-soaked cotton-tipped applicator to
gently separate the liver from the other internal
organs. Liver damage can be minimized by
gently squeezing the sides of the mouse’s
abdomen without use of the applicator to coax
the liver away from the rest of the body. Soak a
strip of gauze in saline and tape it to the insert
such that the liver is positioned below it and the
rest of the internal organs rest on top.

Liver-coverslip interface is poor. Ensure that the liver is moist but not submerged
in liquid on the coverslip. Use Kimteck tissue to
absorb any excess fluids. Allow 10 min for the
tissue to settle and for the formation of stable
interface between the tissue and the coverslip.

Mouse is a heavy breather. Adjust the mouse’s body to minimize breathing
motion. This may involve shifting the mouse
further up the stage insert so that the ribcage is
elevated away from the liver. Choose areas of
the liver close to the edges of the lobe, as these
are usually less prone to motion artifacts.

Poor signal from the
dextran or 2-NBDG
probe

Insufficient probe was injected. Increase the probe concentration to be injected.

The probe was not correctly
injected into the capillary bed
behind the mouse’s eye.

Ensure that the syringe is inserted at the corner
of the eye closest to the nose and behind the
eyeball to get to the back of the eye socket. If
the first retro-orbital injection fails, try injecting
through the other eye.

Laser power is too low. Increase laser power while minimizing
photobleaching.

Blood flow in the selected area is
poor.

Evaluate the fluorescence signal in other areas
of the tissue. If the signal is poor throughout the
tissue, this may indicate extensive disruption to
blood flow and may require euthanasia of the
mouse. It is not uncommon to have local
disruptions in blood flow; therefore, if
fluorescent signal is good in other regions, they
can be imaged.

(Continued)
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Table 3 Troubleshooting, continued

Problem Possible cause Solution

Liver damage Poor blood flow resulted in
ischemia.

Identify an area with normal perfusion. Blood
flow can be seen indirectly, without any
labeling through the eyepiece.

The liver was subjected to
excessive handling.

Handle the liver with cotton-tipped applicators
as little as possible. Use gravity to coax the liver
out of the body cavity and onto the coverslip.
Gently squeeze the sides of the mouse to further
extrude the liver. If using an applicator, soak the
cotton tip in saline.

Poor labeling of PV
hepatocytes with
E-cadherin or
Hoechst 33342

Retro-orbital injection did not work. Reinject the probe.

Probe concentration is too low. Increase the probe concentration 10×.

Blood flow is poor due to damage. Try the procedure again while minimizing
tissue damage.

of the imaging experiment (Fig. 2A-C). Sim-
ilarly, Hoechst 33342 and Alexa Fluor® 647
anti-mouse/human CD324 are used to label
the nuclei and E-cadherin, respectively. Ex-
pect the nuclei of all hepatocytes to be evenly
labeled with Hoechst, whereas the E-cadherin
antibody should selectively label PV hepato-
cytes (Fig. 2B and C and Video 1). The hep-
atic lobule receives blood from six portal veins
that drain into a single central vein (Fig. 1A).
When using a 20× objective, multiple lobules
can be visible within the field of view (Fig.
2A and Video 1). Portal veins can be iden-
tified using the E-cadherin label and/or the
site where dextran appears first when acquir-
ing IVM time-lapse (Fig. 2C and Video 1).

Basic Protocol 3
After analyzing the rate of 2-NBDG up-

take, the slope of the linear increase in 2-
NBDG mean gray value can be compared be-
tween mice and shown as a bar graph, as in
Figure 3C. 2-NBDG retention is best shown
as a line graph, as in Figure 3D, to allow com-
parison of 2-NBDG retention at different time
points and between mice. The retention is cal-
culated in Basic Protocol 3 as the ratio of 2-
NBDG mean gray value in the hepatocytes
compared to the sinusoids. A ratio <1 indi-
cates that more 2-NBDG is present in the si-
nusoids than in the hepatocytes, a ratio of 1
indicates that the 2-NBDG levels are about the
same in sinusoids and hepatocytes, and a ratio
>1 indicates that 2-NBDG levels are higher in
hepatocytes than in sinusoids.

Interestingly, although CV hepatocytes are
known to rely on glycolysis more than PV hep-
atocytes (Rui, 2014), we have found that the
rate of glucose uptake and retention is com-
parable between the three zones (Fig. 3C and
Video 2). This unexpected result may be due
to the strategic distribution of GLUT family
transporters along the hepatic lobule. The glu-
cose concentration is higher in PV than CV
hepatocytes after a meal (Ricken et al., 2015),
and GLUT2, which has a low affinity for glu-
cose, is primarily found in PV hepatocytes
(Ogawa et al., 1996), whereas GLUT1, with
a high affinity for glucose, is primarily found
in CV hepatocytes (Bilir et al., 1993). The low
affinity of GLUT2 for glucose around the PV
leaves some glucose in the blood for use by
the CV hepatocytes, which can rapidly take up
glucose even at low concentrations due to the
high affinity of the GLUT1 transporter. The
organization of glucose transporters in this
fashion may be crucial for maintaining glu-
cose homeostasis, as the liver appears to clear
30%-40% of the glucose entering the portal
vein (Pagliassotti & Cherrington, 1992). Inad-
equate glucose uptake due to loss of glucose
transporter zonation or expression may con-
tribute to high circulating blood glucose levels
and lead to insulin resistance, which could be
investigated by using this protocol in disease
models.

Time Considerations
Basic Protocol 1 can be completed in 45-

60 min.
Stefkovich et al.
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Basic Protocol 2 can be completed in 30-
45 min.

Basic Protocol 3 can be completed in 45-
60 min.
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